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SWAT (Soil and Water Assessment Tool, http://www.brc.tamus.edu/swat/) is a very 
popular semi-distributed watershed model, being good at simulating the long-term impact 
of agriculture management and Best Management Practice (BMP) on surface water 
quality. In order to account for the spatial distribution of the watershed of interest, SWAT 
subdivides the entire watershed into many sub-basins and HRU’s (hydrologic response 
unit) depending on the modeler’s needs. If the number of sub-basins is more than a dozen, 
we could easily end up with hundreds of SWAT input files. Approximately, the number 
of the total SWAT input files is equal to 8 + 6 × (the number of subbasins) + 5 × (the 
number of HRU’s). Without any help, to prepare so many model input files could be a 
daunting task. Fortunately, SWAT model’s GIS interface (BASINS or AVSWAT) 
automatically writes all these input files for us after we’ve collected all the necessary data 
(including DEM, land use, soils, point sources, precipitation, temperature and other 
meteorological data, if any).  However, using the GIS interfaces and GenSen to calibrate 
SWAT model could be a headache, especially when you want to calibrate the model 
against daily measurements or grab samples on a daily time step, because both SWAT 
outputs and measurements need to be converted into a dBase format which could be time 
consuming and end up with huge files. Through my more than a couple of years’ 
experiences of using SWAT, I had explored a short-cut routine to run the SWAT model. 
It only takes about one minute to run SWAT once, including changing input parameters, 
running the model, reading the model’s outputs, and comparing the model’s outputs with 
measurements. This routine involves using a few short computer programs and 
commercial software such as MS Excel, which will be illustrated in more details in the 
following sections. 
 
 

1. Running SWAT in DOS mode 
 
When calibrating SWAT, many users use the Calibration Tool in the GIS interfaces. I 
found that it was very inconvenient and sometimes could be problematic because the GIS 
interface did not always do what you wanted it to do. For example, when I specified 
grazing operation on pasture, the fertilizer such as beef-fresh manure, which should be 
added to pasture while cows are grazing, was not written into the corresponding .mgt 
files. Then I have to edit the .mgt files manually to add the beef-fresh manure 
information into all grazed pasture .mgt files (could be many). However, when I use 
the Calibration Tool to change other parameters in the same .mgt files, the information 
about beef-fresh manure that we added before will be completely wiped out. Then I have 
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to re-enter the same information manually once again for all the grazed pasture .mgt 
files. Therefore, I prefer to run SWAT in DOS mode. 
 
To run SWAT in DOS mode, we only need two things: a text editor and a Windows 
Console. I use NoteTab Light (a freeware, available at http://www.notetab.com) in favor 
of NotePad and WordPad since multiple files can be open and edited simultaneously in 
NoteTab. To open Windows Console, click on Start → All Programs → Accessories → 
Command Prompt. After setting up SWAT simulation run in BASINS or AVSWAT 
interface, it is important to copy the entire txtinout directory into your working 
directory and keep the original txtinout directory intact so that if anything goes 
wrong, you will have a backup to restore the damaged model input files. Basic DOS 
commands such as deleting and renaming files, changing directories etc. can be found at 
http://www.computerhope.com/msdos.htm. 
 
 

2. Changing SWAT parameters using a linkage interface 
 
The linkage interface was developed by Jing Yang (jing.yang@eawag.ch) in Swiss 
Federal Institute for Environmental Science and Technology (EAWAG) to use only one 
text file to change almost all SWAT parameters in different input files. For example, to 
change the value for one SWAT parameter, we don’t have to go through all the SWAT 
input files that contain such parameter. Instead, we just need to change the value for this 
parameter once in an ASCII file (called as model.in) and run an executable file (called 
as sw_edit.exe) before running SWAT. Then the interface will automatically change 
all the values for this parameter in all relevant SWAT input files. In other words, when 
we calibrate the SWAT model, we don’t have to deal with hundreds of SWAT input files. 
Instead, we only deal with one single text file if using this interface. This interface 
package consists of a few files including sw_edit.exe, swEdit.def, 
SwatExtLib.dll, and model.in. The interface also includes function of extracting 
information from the SWAT output files. But we don’t need it here.  
 
After having copied the txtinout directory to your work directory, you can rename the 
txtinout directory to whatever name you like, say etowah, to distinguish it from 
other directories. Before we are able to use this linkage interface, we need to do two more 
things: one is to copy the txtinout directory one more time into the etowah directory 
and rename it as backup; the other is to copy the interface files (sw_edit.exe, 
swEdit.def, SwatExtLib.dll, and model.in) into etowah directory. Detail 
information about this linkage interface is provided in the Users’ Manual for this 
interface. In this section, we only briefly illustrate how to use it. 
 
A typical example of the model.in file is provided in Example 1. One line is a 
command to change one parameter’s values in relevant SWAT input files. Each 
command is composed of four parts. As seen in the file, the first part consist of one 
character in the front of the command being either v, r, or a. It defines how to change 
the parameter’s values. It is connected with the rest of the line by double underscores (i.e., 
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_ _). The second part of the command consists of a SWAT parameter’s name, a dot, and 
the file extension name of the SWAT input files where the parameter can be found. For 
the file extension names there is only one exception. That is, if the parameter is in 
crop.dat, the file extension name is crp instead of dat (see Lines 4 and 5). The third 
part of the command is to define the scope where the changed parameter value should 
apply. The scope can be defined by land use, sub-basins (or crop indices), soil 
hydrological group, or soil texture. The defining scopes are connected with the second 
part by multiple double underscores depending on what information is used to define the 
scopes. For example, if the land use is used to define the scope, there are three 
consecutive double underscores (six underscores) between the second and third part of 
the command, like in Lines 1-3. If crop indices or sub-basin numbers are used to define 
the scope, then there are four double underscores between the second and third part of the 
command, like in Lines 4-5 (crop indices) and in Line 9 (sub-basin numbers). For other 
type of scopes, please refer to the Users’ Manual. If there is no specific scope provided, 
the default scope is the entire watershed. The last (fourth) part of the command is a 
numeric number whose meaning is associated with the first character of the command. 
Multiple spaces (or tabs) are used to separate it from the first three parts.  
 
If the first character of the command is v, then the number supplied in the last part is the 
value that the parameter will literally take in the SWAT input files. For example, in Line 
8, the parameter ALPHA_BF in all .gw files will take a value of 0.01365 for the entire 
watershed. If the first character is a, then the number in the last part is the value by which 
the parameter will add to the original parameter value. For example, in Line 6, the new 
value of the parameter CN2 in each .mgt file will be equal to the original CN2 value in 
each .mgt file adding -11.0. The original values of CN2 are in the .mgt files that 
were stored in the backup directory which in turn resides in the current working 
directory. If the first character of the command is r, then the number in the last part is a 
ratio by which the parameter will change based on the original parameter value. For 
example, in Line 2, the value of parameter USLE_K in .sol files whose land uses are 
FRSD will increase 50% from their original values, while in Line 3, the value of 
parameter USLE_K in .sol files whose land uses are PAST will decrease 5% from their 
original values.  
 
1 v__IURBAN.hru______URLD   1 
2 r__USLE_K.sol______FRSD   0.5 
3 r__USLE_K.sol______PAST  -0.05 
4 r__USLE_C.crp________6-8,40  1.5 
5 r__USLE_C.crp________2,12  -0.05 
6 a__CN2.mgt    -11.0 
7 a__SOL_AWC.sol    0.0 
8 v__ALPHA_BF.gw    0.01365 
9 r__SOL_SOLP.chm________1-5,10  0.0 
10 v__SURLAG.bsn     1.0 
11 v__PSP.bsn     0.4 
12 v__RS2.swq     0.001 

 
Example 1.  A typical model.in file (The numbers in left column are line labels; they are not 
contained in the file) 
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After editing and saving the model.in file (there is no need to close the model.in 
file), before switching to the Windows Console window and running sw_edit.exe 
(the linkage interface executable file) in the command line, you need to make sure that 
the file name provided in the third line in the swEdit.def file (see Example 1a) is 
model.in, as well. However, you may use a different file name (other than model.in) 
for the linkage interface input file, say model2.in. In that case, the file name provided 
in the third line in the swEdit.def should be changed to model2.in, accordingly. In 
other words, the file name you use in the linkage interface input file should be consistent 
with file name provided in the third line of the file swEdit.def.  
 
After you run sw_edit.ext in the Windows Console window, the parameters in the 
relevant SWAT input files will have been changed to the values that are specified in the 
linkage interface file (e.g., model.in). Subsequently, running swat2000.exe in the 
command line will generate a new set of model outputs based on the newly adjusted 
SWAT parameters.  
 
1 0 
2 backup 
3 model.in 
4 parval.in 
5 0 
6 110 
7 0 

 
Example 1a. A typical swEdit.def file (The numbers in left column are line labels; they are not 
contained in the file) 
 
 

3. Post-processing SWAT outputs 
 

3.1  basins.rch file 
 
Here we only discuss how to post-process the basins.rch file printed in a daily time 
step by SWAT. Since time series contained in the basins.rch file printed in monthly 
or yearly time step are fairly short, they can be imported into MS Excel worksheet quite 
easily. The post-processors essentially include two files: rch2ssf1.exe and 
tsproc.exe. The former is a short Fortran program I coded by myself. An illustration 
of how to use it has been provided in another note for PEST novices entitled “Getting 
Started with PEST”. The latter is a more sophisticated Surface Water Utility package 
provided by PEST author John Doherty which can be downloaded from website 
(http://www.sspa.com/pest/utilities.html). The Users’ Manual for this utility program is 
also available in this website. A brief illustration of how to use this utility program has 
also been provided in “Getting Started with PEST”. Therefore, this section assumes that 
the reader has been familiar with using these two Fortran programs.  
 
A two-line batch file called swatpost.bat (see Example 2) was constructed to run 
rch2ssf1.exe and tsproc.exe consecutively. After running SWAT we run 
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swatpost.bat in the command line to convert the basins.rch file into a few text 
files which contain daily time series of streamflow and water quality parameters of 
interest. A typical rch2ssf.dat file looks like Example 3 and a typical tsproc.in 
file looks like Example 4; while a tsproc.tsp file looks like Example 5.  
 
rch2ssf1 rch2ssf.dat 
tsproc < tsproc.in > nul 

 
Example 2. SWAT post-processor batch file 
 
55 
FLOW_OUT 
SEDCONC 
ORGP_OUT 
MINP_OUT 

 
Example 3. An RCH2SSF data file 
 
tsproc.tsp 
tsproc.rec 
n 
n 
 
Example 4. A TSPROC input file 
 
# Block 1 
START SETTINGS 
  DATE_FORMAT mm/dd/yyyy 
  CONTEXT Etowah_River 
END SETTINGS 
 
# Block 2 
START GET_SERIES_SSF 
  CONTEXT all 
  FILE flow_out.ssf 
  SITE reach55 
  NEW_SERIES_NAME mflow1 
END GET_SERIES_SSF 
 
# Block 3 
START REDUCE_TIME_SPAN 
  CONTEXT all 
  SERIES_NAME mflow1 
  NEW_SERIES_NAME mflowst 
  DATE_1 01/01/1992 
  TIME_1 00:00:00 
  DATE_2 12/31/1996 
  TIME_2 00:00:00 
END REDUCE_TIME_SPAN 
 
# Block 4 
START GET_SERIES_SSF 
  CONTEXT all 
  FILE sedconc.ssf 
  SITE reach55 
  NEW_SERIES_NAME mtss0 
END GET_SERIES_SSF 
 
# Block 5 
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START NEW_TIME_BASE 
  CONTEXT all 
  SERIES_NAME mtss0 
  TB_SERIES_NAME mflowst 
  NEW_SERIES_NAME mtssst 
END NEW_TIME_BASE 
 
# Block 6 
START GET_SERIES_SSF 
  CONTEXT all 
  FILE orgp_out.ssf 
  SITE reach55 
  NEW_SERIES_NAME mop0 
END GET_SERIES_SSF 
 
# Block 7 
START NEW_TIME_BASE 
  CONTEXT all 
  SERIES_NAME mop0 
  TB_SERIES_NAME mflowst 
  NEW_SERIES_NAME mopst 
END NEW_TIME_BASE 
 
# Block 8 
START GET_SERIES_SSF 
  CONTEXT all 
  FILE minp_out.ssf 
  SITE reach55 
  NEW_SERIES_NAME mip0 
END GET_SERIES_SSF 
 
# Block 9 
START NEW_TIME_BASE 
  CONTEXT all 
  SERIES_NAME mip0 
  TB_SERIES_NAME mflowst 
  NEW_SERIES_NAME mipst 
END NEW_TIME_BASE 
 
# Block 10 
START SERIES_CLEAN 
  CONTEXT all 
  SERIES_NAME mflowst 
  UPPER_ERASE_BOUNDARY 0.0 
  SUBSTITUTE_VALUE 0.001 
  NEW_SERIES_NAME mflow4pst 
END SERIES_CLEAN 
 
# Block 11 
START SERIES_EQUATION 
  CONTEXT all 
  NEW_SERIES_NAME mtpst 
  EQUATION ((mipst + mopst) / mflow4pst) * 0.01157 
END SERIES_EQUATION 
 
# Block 12 
START LIST_OUTPUT 
  CONTEXT Etowah_River 
  FILE modelfl.txt 
  SERIES_NAME mflowst 
  SERIES_FORMAT short 
END LIST_OUTPUT 
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# Block 13 
START LIST_OUTPUT 
  CONTEXT Etowah_River 
  FILE modelss.txt 
  SERIES_NAME mtssst 
  SERIES_FORMAT short 
END LIST_OUTPUT 
 
# Block 14 
START LIST_OUTPUT 
  CONTEXT Etowah_River 
  FILE modeltp.txt 
  SERIES_NAME mtpst 
  SERIES_FORMAT short 
END LIST_OUTPUT 

 
Example 5. A TSPROC data file 
 
A complete basins.rch file printed in daily time step can be very large. It contains as 
many as 42 stream flow and water quality variables. But its size can be reduced following 
the instructions given in the SWAT User’s Manual (Pages 66-67) by selectively printing 
necessary stream variables such as those listed in Example 3. It should be noted that the 
stream variables printed in the basins.rch should at least include those listed in 
Example 3. The first line of Example 2 generates a number of Sample Site Files for the 
stream variables in Reach 55, which are listed in Example 3. One .ssf file was 
generated for each variable. These .ssf files are readable by the TSPROC utility 
program. The second line of Example 2 converts the organic-P and inorganic-P loadings 
in the basins.rch file into total P concentrations in stream and prints the downstream 
flow rate (in m3/s), total suspended solid concentration (in mg/L) and total P 
concentration (in mg/L) in stream to a number of text files (modelfl.txt, 
modelss.txt, and modeltp.txt, respectively) which can be readily imported into 
MS Excel worksheets.  
 
Take the following steps to import the text files into MS Excel and compare the model 
results and their corresponding observations. 
 
Step 1: Open MS Excel and create a new worksheet. In the first row, write the column 
names such as Date, Observation, Simulation, etc. 
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Step 2: Click File → Open and navigate to your work directory. Click on the down-
pointing arrow in the Files of Type of the MS Excel File Open dialogue window and 
choose Text Files (*.prn, *.txt, *.csv).  
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Step 3: If you wanted to import modelfl.txt (SWAT simulated daily stream flow) into MS 
Excel, select modelfl.txt and click open. Then the Text Import Wizard dialogue window 
will pop up. 
 

 
 
Step 4: Click Finish. The model simulated stream flows will then be imported into 
spreadsheet. 
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Step 5: Select all data in the first column and paste into the newly created worksheet (see 
Step 1) under column name “Simulation”. 
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Step 6: Write the dates for the data. For example, our SWAT model ran from January 1, 
1992 to December 31, 1996. Then, we write 1/1/1992 in the first cell under “Date” 
column. 
 

 
 
Step 7: In Cell A3, type “=A2+1”.  
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Step 8: Copy Cell A3 to the rest cells of the first column named “Date”. 
 

 
 
Step 9: Copy the corresponding observed stream flows in the second column. Then 
graphs of comparing the observed and modeled stream flow can be plotted MS Excel 
graphic tools. How to download daily stream flow observations from USGS is described 
in another class note entitled “Obtaining surface water observations from USGS 
NWISWeb”. 
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If the streamflow has daily recordings like the USGS gage station recording for  the 
Etowah River at Canton, GA, a Nash-Sutcliffe coefficient and other indices can be 
calculated through this post-processor as well. It only requires adding the following 
blocks (see Example 6) into the TSPROC data file presented in Example 5. But, it should 
be noted that Blocks 15-17 in Example 6 ought to be inserted before Block 12 in 
Example 5. Otherwise, TSPROC will issue an error message since all the 
LIST_OUTPUT blocks should be placed at the end of the TSPROC data file if the 
TSPROC is used as a model post-processor. It also should be noted that file 
cantnflw03.wdm containing the measured daily streamflow of Etowah River at 
Canton must be present in the current working directory. 
 
# Block 15 
START GET_SERIES_WDM 
  CONTEXT all 
  FILE cantnflw03.wdm 
  DSN 201 
  NEW_SERIES_NAME ofl1 
  DEF_TIME 00:00:00 
  FILTER -999.99 
END GET_SERIES_WDM 
 
# Block 16 
START NEW_TIME_BASE 
  CONTEXT all 
  SERIES_NAME ofl1 
  TB_SERIES_NAME mflowst 
  NEW_SERIES_NAME oflowst 
END NEW_TIME_BASE 
 
# Block 17 
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START SERIES_COMPARE 
  CONTEXT Etowah_River 
  SERIES_NAME_SIM mflowst 
  SERIES_NAME_OBS oflowst 
  NEW_C_TABLE_NAME comp_flow 
  BIAS yes 
  NASH_SUTCLIFFE yes 
END SERIES_COMPARE 
 
# Block 18 
START LIST_OUTPUT 
  CONTEXT Etowah_River 
  FILE camparison.txt 
  C_TABLE_NAME comp_flow 
  SERIES_FORMAT long 
END LIST_OUTPUT 

 
Example 6. More blocks to calculate Nash-Sutcliffe coefficient 
 
 

3.2  basins.sbs file 
 
In general, the basins.rch file is used for SWAT model calibration since most of the 
observations of the watershed’s behavior are obtained by measuring streamflow and 
water quality parameters in streams and rivers. But yearly outputs from HRU’s stored in 
the basins.sbs file are normally used to calculate sediment and nutrient yields from 
uplands for different land uses, that is, Export Coefficients (EC) of sediment or nutrients 
for different land uses.  
 
After we have calibrated the streamflow and water quality parameters in streams in a 
daily time step, we need to change the value of IPD in basins.cod file from 0 (print 
outputs in a daily step) to 2 (print outputs in a yearly step), in order to use an MS Excel 
spreadsheet to summarize the sediment and nutrients yields from different land uses. To 
reduce the size of the basins.sbs file, we can follow the instruction of SWAT User’s 
Manual (Pages 67-68) to selectively print necessary variables only. For modeling 
sediment and phosphorus, the last two lines in the basins.cod file can be written as 
follows (see Example 7). Then, only water yield (mm H2O), sediment yield (metric 
tons/ha), USLE soil loss (metric tons/ha), Organic P yield (kg P/ha), Sediment-associated 
inorganic P yield (kg P/ha), and Soluble P (kg P/ha) will be printed in the basins.sbs 
(HRU output) file. 
 
HRU output variables 
 20 21 22 42 43 48  0  0  0  0  0  0  0  0  0  0  0  0  0  0 

 
Example 7. Last two lines in basins.cod file for modeling sediment and phosphorus 
 
After we ran swat2000.exe one more time, we used the MS Excel spreadsheet to 
import the basins.sbs file in the following steps. 
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Step 1: Open MS Excel, if it is not already open; click File→ Open and navigate to your 
working directory (etowah in this case); select All File (*.*) in Files of type; then select 
basins.sbs and click Open button. 

 
 
Step 2: File Import Wizard window pops up; select Fixed Width and click Next. 
 

 
 
Step 3: Add one vertical line between Columns MON and AREA and adjust other lines to 
appropriate places; click Next and click Finish. 
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Step 4: Scroll down towards the end of the file until Column MON turns from a specific 
year (e.g., 1996) to the total number of simulated years (e.g., 5) because we wanted 
average yields for the entire simulation period. 
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Now, we want to build a relational spreadsheet to summarize the Export Coefficients of 
sediment and nutrients in the following steps. 
 
Step 5: Copy the title and average yields over the simulation period to a new spreadsheet 
file (called as “Etowah Loads  from Land Uses.xls”) and rename the current worksheet as 
“All Landuse” or anything you like. 
 

 
 
Step 6: Place cursor in the first row and click Data →Filter →AutoFilter. 
 

 
 
Step 7: Click the down-pointing arrow in the first cell (A1) and select AGRR. 
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Step 8: Copy all AGRR rows to “Sheet2” and rename the sheet name as “Row Crop”. 
 

 
 
Step 9: Calculate the total area of row crop land use and the average yields of water, 
sediment and phosphorus over the seven row crop HRU’s.  
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Step 10: Repeat Steps 7-9 for other land uses. Notice that the urban land use was named 
as “BERM” in the basins.sbs (HRU output) file. For forest, you can put all three 
forest land uses (FRSD, FRSE, FRST) together in one worksheet. 
 

 
 
Step 11: Insert another worksheet and called “Summary” and name the columns and rows 
as follows. 
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Step 12: In order to obtain the total area for Row Crop HRU’s, place cursor at B3 and 
type “=”. 
 

 
 
Step 13: Click on worksheet “Row Crop” and click on G10 (the total area of Row Crop). 
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Step 14: Hit “Enter”; the number 5.09 was then entered into B3 in “Summary” worksheet 
as wanted. 
 

 
 
If you click on the number 5.09, you will notice that the formula line writes “Row 
Crop”!G10, which implies that the number 5.09 in worksheet “Summary” B3 was 
directly taken from worksheet “Row Crop” G10. Therefore, the relational worksheet for 
Row Crop area has been established. 
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Step 15: Repeat Steps 12-14 to establish the relational worksheet for other cells. 
 

 
 
Step 16: Total P yield is equal to the sum of organic P, sediment P and soluble P yields. 
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Step 17: The relational worksheet has been successfully established. Next time when we 
run SWAT using different parameter values (like during the process of model calibration), 
we simply follow Steps 1-4 to import the newly generated basins.sbs into MS Excel 
and copy the needed information into worksheet “All Landuse” following Step 5. Then 
the “Summary” worksheet will be automatically updated. 
 
 

4. Using Browser to check daily basins.sbs file 
 
Sometimes we also want to check on the daily dynamics of some variables in HRU’s 
such as evapotranspiration, crop yield, P uptake, leaf area index etc., the daily printed 
basins.sbs would be too large to be imported into MS Excel. In such a case, Browser 
will be very helpful. Browser can be downloaded from http://www.ncea.org.au/Browser/. 
Its usage can be found in that website as well so we won’t repeat here. 
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